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This document contains important information about restricted functionality, known limitations, and bug 
fixes for Informatica 10.2.2.

Installation and Upgrade
Version 10.2.2 supports Informatica big data products, such as Big Data Management and Big Data 
Quality. It does not support traditional products such as PowerCenter and Informatica Data Quality. If 
your domain contains both big data and traditional products, you must split the domain before you 
perform the upgrade.

Informatica Upgrade Support

You can directly upgrade to 10.2.2 from Informatica 10.0, 10.1, 10.1.1, 10.2, and 10.2.1.

If the product version that is currently installed cannot be upgraded to Informatica 10.2.2, you must first 
upgrade to a supported version. To determine the Informatica product version that is currently installed, 
click Help > About Informatica Administrator in the Informatica Administrator header area.

Note: For information about Support EOL statements, contact Informatica Global Customer Support or 
see, https://network.informatica.com/docs/DOC-16182

The following table describes the Informatica product versions from which you can upgrade:

Informatica Version Upgrade Path Comments

9.0.1 9.1.0 -> 9.6.1 -> 10.2 ->10.2.2 After you upgrade to version 9.1.0, you must 
upgrade to version 9.6.1, then upgrade to 
version 10.2, and then upgrade to version 
10.2.2.

9.1.0 9.6.1 -> 10.2 ->10.2.2 After you upgrade to version 9.6.1, you must 
upgrade to version 10.2, and then upgrade to 
version 10.2.2.

9.5.0 9.6.1 -> 10.2 ->10.2.2 After you upgrade to version 9.6.1, you must 
upgrade to version 10.2, and then upgrade to 
version 10.2.2.

9.5.1 9.6.1 -> 10.2 ->10.2.2 After you upgrade to version 9.6.1, you must 
upgrade to version 10.2, and then upgrade to 
version 10.2.2.

2 2020-06-22

https://network.informatica.com/docs/DOC-16182


Informatica Version Upgrade Path Comments

9.6.0 9.6.1 -> 10.2 ->10.2.2 After you upgrade to version 9.6.1, you must 
upgrade to version 10.2, and then upgrade to 
version 10.2.2.

9.6.1 10.2 ->10.2.2 You must first upgrade to version 10.2 and 
then upgrade to version 10.2.2.

10.0.0 10.2.2 You can directly upgrade to version 10.2.2.

10.1.0 10.2.2 You can directly upgrade to version 10.2.2.

10.1.1 10.2.2 You can directly upgrade to version 10.2.2.

10.2.0* 10.2.2 You can directly upgrade to version 10.2.2.

10.2.1* 10.2.2 You can directly upgrade to version 10.2.2

*If a HotFix is applied on 10.2, an upgrade to 10.2.2 is supported only from 10.2 HF1. 

Upgrading to Version 10.2.2

System Memory

Effective in version 10.2.2, when you upgrade from a previous version to version 10.2.2, verify that 
sufficient system memory is available for infaservice.bat or infaservice.sh. To avoid any Java memory 
errors, set a heap size of at least 1024.

To increase the system memory when the heap size is less than 1024, set -xmx to 1024 in the 
ICMD_JAVA_OPTS environment variable as seen in the following syntax:

INFA_JAVA_OPTS="-Xmx1024m ${INFA_JAVA_OPTS} -XX:MaxMetaspaceSize=256m" 
(PLAT-23071)

Running Mappings with High or Low Precision

Effective in version 10.2.2, mappings that use the Spark engine run in high precision mode by default.

You can disable the high precision setting in the Developer tool in the mapping run-time configurations 
advanced settings:

1. In the Developer tool, select Window > Preferences.

2. Select Informatica > Run Configurations > Mapping.

3. Select the Advanced tab.

4. Deselect High precision.

You might want to do this to run mappings on the Spark engine that were developed in an earlier release 
and that you prefer to run with low precision. In some cases, such as a mapping in which scale is not 
specified, mappings fail at the default high precision setting and require low precision to run.
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Distribution Support

Informatica big data products support Hadoop and Databricks environments. In each release, 
Informatica adds, defers, and drops support for Hadoop distribution versions. Informatica might 
reinstate support for deferred versions in a future release.

Big Data Management added support for the Databricks environment and supports the Databricks 
distribution version 5.1.

The following table lists the supported Hadoop distribution versions for Informatica 10.2.2 big data 
products:

Product EMR HDI CDH HDP MapR

Big Data 
Management

5.16 3.6.x 5.15
5.16

2.6.x 6.0.x MEP 5.0

Big Data 
Streaming

5.16 3.6.x
Note: HDI is 
supported only 
for ADLS non-
Kerberos.

5.15
5.16

2.6.x Deferred 
support

Enterprise Data 
Catalog

N/A 3.6.x
Note: HDI is 
supported only 
for WASB non-
Kerberos.

5.15
5.16
Note: You can 
use OpenJDK 
1.8.0 only on 
Enterprise Data 
Catalog 
deployed on a 
CDH 5.16 
Hadoop 
distribution.

2.6.x N/A

Enterprise Data 
Lake

5.16 3.6.x
Note: HDI is 
supported only 
for ADLS and 
WASB non-
Kerberos.

5.15
5.16

2.6.x 6.0.x MEP 5.0

To see a list of the latest supported versions, see the Product Availability Matrix on the Informatica 
Customer Portal: 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Technical Preview Support

Effective in version 10.2.2, Informatica includes the following functionality for technical preview:

Microsoft Azure SQL Data Warehouse

• You can configure full pushdown optimization to push transformation logic to source databases 
and target databases.
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• You can use Microsoft Azure SQL Data Warehouse objects as dynamic sources and targets in a 
mapping.

PowerExchange for Microsoft Azure Cosmos DB SQL API

Informatica added full support for the Azure Databricks environment. PowerExchange for Microsoft 
Azure Cosmos DB SQL API for the Databricks environment is available for technical preview.

Preview hierarchical data

You can preview hierarchical data within a mapping in the Developer tool. Choose sources and 
transformations as preview points in a mapping that contain the array, struct, and map hierarchical 
types

Kafka targets

You can write to Kafka messaging targets. Apache Kafka is a publish-subscribe messaging system. 
Kafka brokers process data in the form of messages, publishes the messages to a topic, subscribes 
the messages from a topic, and then writes it to the Kafka target.

Kafka connections for streaming

When you create a Kafka connection, you can use additional connection properties to configure the 
Kafka broker.

Technical preview functionality is supported but is unwarranted and is not production-ready. Informatica 
recommends that you use in non-production environments only. Informatica intends to include the 
preview functionality in an upcoming GA release for production use, but might choose not to in 
accordance with changing market or technical circumstances. For more information, contact 
Informatica Global Customer Support.

Dropped Support

Effective in version 10.2.2, Informatica dropped support for the following functionality:
Hive engine

Informatica dropped support for the Hive mode of execution for jobs run in the Hadoop environment. 
You cannot configure or run jobs on the Hive engine. You need to update all mappings and profiles 
configured to run on the Hive engine before you upgrade.

Informatica continues to support the Blaze and Spark engines in the Hadoop environment, and it 
added support for the Databricks Spark engine in the Databricks environment.

Refer to the Informatica 10.2.2 upgrade guides for information about updating mappings and 
profiles.

Greenplum and Netezza Adapters

Informatica dropped support for mappings run in the Hadoop environment for the following 
adapters:

• PowerExchange for Greenplum

• PowerExchange for Netezza

Informatica continues to support Netezza and Greenplum mappings in the native environment.
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Spark Streaming

Big Data Streaming adopted Spark Structured Streaming and dropped support for Discretized Stream 
(DStream). Structured Streaming brings new capabilities to handle late arrival of streaming events 
and to order the processing of streaming data based on source timestamp.

Due to the changes, you will need to update mappings and mapping objects after you upgrade. 
Informatica suggests that you consider and review your implementation before you upgrade.

Refer to the Big Data Management Integration Guide for information about completing the upgrade.

Note: You can contact Informatica Global Customer Support for questions about dropped support.

Deferred Support

Effective in version 10.2.2, Informatica deferred support for the following functionality:
Python transformation

Support for binary ports in the Python transformation is deferred. Informatica intends to reinstate 
support in a future release.

Streaming mapping objects

With the changes in streaming support, the following objects in streaming mappings are deferred:

• JMS sources

• MapR Streams sources and targets

• Data Masking transformations

• Joiner transformations (master outer, detail outer, and full outer join types)

• Rank transformations

• Sorter transformations

Informatica intends to reinstate support in a future release.

Data Processor Transformation on Windows Clients

If you install version 10.2.2 on a Windows operating system and you plan to use Data Processor 
transformations, verify the PATH on the Developer tool machine.

Access the run.bat file:

<informatica_install_path>\clients\DeveloperClient\run.bat 
Verify that the PATH environment variable contains the Java bin folder path:

<informatica_install_path>\clients\java\jre\bin
If the environment variable does not contain the Java bin folder path, add the path to the variable:

set PATH=%IFCONTENTMASTER_HOME%\bin;<informatica_install_path>\clients\java\jre\bin;
%infa.nativeDir%\bin;%PATH%
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For example:

set PATH=%IFCONTENTMASTER_HOME%\bin;C:\informatica\10.2.2\clients\java\jre\bin;
%infa.nativeDir%\bin;%PATH%

On some Windows installations, for example, on Windows 8.1 or on Windows Server 2008 R2, the PATH 
environment variable does not contain the Java bin folder path by default. In this case, if you do not add 
the folder path to the variable, the Developer tool cannot create or open Data Processor transformations. 
(B2BT-517)

PowerExchange for MongoDB

Effective in version 10.2.2, the Schema Editor for the Simba MongoDB ODBC 64-bit driver is no longer 
available in the following directory:

<Informatica installation directory>/clients/tools/mongodb/Tools
To use the Schema Editor for the Simba MongoDB ODBC 64-bit driver, apply the Informatica EBF-13871.

Informatica Developer Name Change

In version 10.2.2, Informatica Developer is now called Big Data Developer.

For big data releases, the tool is renamed to Big Data Developer. A big data release includes products 
such as Big Data Management and Big Data Quality.

For traditional releases, the tool name remains Informatica Developer. A traditional release includes 
products such as PowerCenter and Data Quality.

10.2.2 Fixed Limitations and Closed Enhancements

Application Service Fixed Limitations

Review the Release Notes of previous releases for information about previous fixed limitations.

The following table describes fixed limitations:

Bug Description

OCON-13454 The Developer tool fails to connect to an active Metadata Access Service process even if the 
Metadata Access Service is configured for high availability.

MRS-1795 When the Model Repository Service runs out memory, no Java heap dumps are generated.

MRS-1571 When you enable the Model Repository Service for DEBUG level of logging, the service generates 
multiple ERROR level log messages.

BDM-17402 When the Data Integration Service runs on a grid, the service waits for applications to load before 
the service starts up.
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Bug Description

BDM-17301 The Data Integration Service restarts if deployed applications take more than 15 minutes to load 
during service start-up.

BDM-17293 Application details cannot be fetched from the Data Integration Service while the Data Integration 
Service is deploying applications.

BDM-17055 Requests to submit mappings hang if the application that contains the mapping is loading on the 
Data Integration Service during service start-up.

Big Data Management Fixed Limitations

Review the Release Notes of previous releases for information about previous fixed limitations.

The following table describes fixed limitations:

Bug Description

OCON-17874 When you run a Sqoop mapping with a TLS-enabled domain and SparkSqoopDisSideInvocation 
property is set to true, the mapping fails because the location of the truststore system property of 
the Data Integration Service gets modified from -Djavax.net.ssl.trustStore= 
$INFA_HOME/services/shared/security/infa_truststore.jks to -
Djavax.net.ssl.trustStore=$INFA_HOME/externaljdbcjars/../java/jre/lib/
security/cacerts.

OCON-16535 When you run a Sqoop mapping on the Spark engine, the MapReduce job fails because the Data 
Integration Service ignores the hadoop.security.token.service.use_ip configuration property in the 
core-site.xml file.

IDL-8652 If you run a mass ingestion specification that contains more than 2,000 tables, a majority of the 
ingestion mapping jobs fail with the following error:
SEVERE: UserDefinedJob execution failed

IDL-10354 When a run instance of a mass ingestion specification completes, the Summary page in the Mass 
Ingestion tool continues to display the status as RUNNING. The Summary page updates the status 
only after you navigate to the Execution Statistics page for the run instance.

BDM-23599 Connectivity to Hive sources and targets on Amazon S3 with SSE-KMS authorization fails on a 
Hortonworks HDP 2.6.1 or higher version cluster with an error reading "The encryption method 
specified is not supported."

BDM-23199 When a sorted Joiner transformation joins data from a single source, data loss can occur if the 
row size for key columns exceed the data cache size.

BDM-22862 If the Spark engine runs a mapping that creates temporary Hive tables and the data contains 
string values with newline characters (\n), the newline character is treated as the end of one 
record. For example, if the temporary Hive table stores the string 'abc \n def', the first record 
is 'abc' and the second record is 'def'.
One situation where the issue occurs is in a mapping that contains an Update Strategy 
transformation. When the mapping runs on the Spark engine, the Update Strategy transformation 
stages data in temporary Hive tables.
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Bug Description

BDM-22754 When the DTM runs out of memory and shuts down, the subsequent mappings sometimes fail with 
a NullPointerException during mapping initialization.

BDM-22736 When you run a mapping with a large number of Joiner transformations on the Spark engine, the 
Data Integration Service runs out of memory.

BDM-21657 Blaze mapping reads NULL data from a Parquet format Hive table.

BDM-21324 Incorrect query generated for a Hive update strategy when the column name starts with a number.

BDM-18221 If the tez.tez-ui.history-url.base is set to NULL or if it is not present in the cluster configuration, 
the Tez jobs fail with a null pointer exception.

BDM-18195 When you disable yarn.timeline-service in the cluster configuration, the Tez view does not show 
the Hadoop job.

BDM-18173 The duration taken to load the Summary Statistics and Execution Statistics in the Administrator 
tool for a non-Administrator user is more when compared to an Administrator.

BDM-17879 Slow performance of domain when OS profiles are enabled.

BDM-17849 When you use infacmd command line program to export a mapping that contains an XML payload 
of a complex data type, the export fails with the following error:
com.sun.xml.xsom.parser.XSOMParser cannot be found by 
com.infa.products.sdk.adapter.parser.xml.utils_1.1.0
com/sun/xml/xsom/parser/XSOMParser

[ICMD_10033] Command [ExportObjects] failed with error [[OIECMD_10006] 
Error occurred during export function. See previous error.].

BDM-17831 The JVM options for debugging are disabled for Data Integration Services.

BDM-17755 When a decimal port on a partitioned, bucketed Hive target is disconnected, a passthrough 
mapping that runs on the Blaze engine fails.

BDM-17698 When you use the Cloudera Connector Powered by Teradata to run a Sqoop TDCH mapping, the 
mapping fails with the following error: Missing argument for option: staging-database

BDM-17685 The Data Integration Service does not remove temporary empty files from the operating system 
profile target directory when all the following conditions are true:
- The Data Integration Service is enabled to use operating system profiles.
- The mapping writes to an HDFS target.
- The mapping runs on the Hive engine.

BDM-17541 When you run a mapping by choosing Window > Preferences > Run configurations > Mapping, the 
Developer tool attempts to re-establish connections with all configured domains. Depending on 
the connection quality, this may result in dramatically slower performance.

BDM-17175 After you import the workflow into the Model repository, you cannot create a parameter set for the 
SQL parameter with the empty default value.

BDM-16843 After you import an SQL parameter into the Model repository, you can edit the parameter value but 
you cannot reset it later to the default empty or NULL value.
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Bug Description

BDM-14626 When you do not assign a connection in the physical data object, the workflow application fails to 
deploy.

BDM-14139 In a Hortonworks HDP or an Amazon EMR environment, a mapping run on the Spark engine fails 
when all of the following conditions are true:
- The mapping writes to an Avro target.
- The schema contains an array or a map that exceeds two levels of nesting.
- A struct element exists at the third or higher level of nesting.
For example, when you write to an Avro target with a schema such as array(array(struct)) or 
array(map(string, struct)), the mapping fails.

BDM-13107 When you run a mapping with Spark monitoring enabled, performance bottlenecks can appear. The 
performance varies based on the mapping complexity.

Developer Tool Fixed Limitations

Review the Release Notes of previous releases for information about previous fixed limitations.

The following table describes fixed limitations:

Bug Description

OCON-14447 When you use an SQL transformation to read multiple records from a stored procedure, the data 
preview fails.

OCON-13057 When you use an ODBC connection with Microsoft SQL Server as the ODBC provider, and run a 
data preview on a Microsoft SQL Server named instance, data preview fails.

IDQ-7121 The Developer tool raises an error if you import a mapplet to the Model repository and the 
following conditions are true:
- The mapplet that you import replaces a mapplet in the repository.
- The mapplet in the repository reads a token set that the replacement mapplet does not read.
- The two mapplets have the same configuration, including a Labeler transformation that reads 

the token set.

BDM-20406 The Developer cannot open an object when there is a mismatch between the IDs of the local and 
the cached object. It returns the following error: Duplicate object of ID

BDM-18315 In the Developer tool, the Header command write property for flat files does not support any 
escape characters.

BDM-17541 When you run a mapping by choosing Window > Preferences > Run configurations > Mapping, the 
Developer tool attempts to re-establish connections with all configured domains. Depending on 
the connection quality, this may result in dramatically slower performance. To work around this 
issue, delete unused domain configurations from the Developer tool.

Enterprise Data Catalog Fixed Limitations and Closed Enhancements (10.2.2)

Review the Release Notes of previous releases for information about previous fixed limitations.
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The following table describes fixed limitations:

Bug Description

LDM-7044 Sometimes, the test connection fails for an Axon 
resource if you do not select the Enable Secure 
Communication option when you create the resource.

LDM-5987 Enterprise Data Catalog and Catalog Administrator 
display junk characters in the search results and 
resource properties section after you change the server 
locale to Japanese.

EIC-8243 You cannot create a custom attribute with the same 
name as an existing system attribute.

EIC-8032 For an Apache Atlas instance running on a Kerberos-
enabled Hortonworks Data Platform (HDP) cluster, the 
Apache Atlas resource extracts source and target 
information only for Hive.

EIC-7969 When you perform an installation or an upgrade in the 
silent mode and specify a value other than 1 or leave 
the value blank for the property INSTALL_LDM, the 
Model Repository Service upgrade fails.

EIC-6422 When you update the Catalog Service from any 
previous version to version 10.2.1 Update 1, the 
following error occurs:
ScannerPluginRegistrationManager@288] 
- [ModelValidationException_00016] 
Datatype for Attribute [FireonUpdated] 
has been altered.
Expected: [core.Boolean]. 
Found: [core.Integer].

EIC-6384 After you import a CSV file that has assets with 
associated business titles, Enterprise Data Catalog 
does not display the associated business titles for the 
assets.

EIC-6080 In Enterprise Data Catalog, the Allow Filtering option 
for a default custom attribute named Department is 
not enabled even if you have enabled the Allow 
Filtering option for the custom attribute in the Catalog 
Administrator.

EIC-6073 Enterprise Data Catalog displays a mapping that is 
deleted even after you re-run the PowerCenter resource 
in Catalog Administrator.

EIC-5999 Enterprise Data Catalog displays incorrect search 
results when you search the catalog using an asset 
name that contains special characters.
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Bug Description

EIC-5916 An Amazon S3 resource fails with the following data 
validation error:
Error occured in scanner execution 
java.util.concurrent.ExecutionException: 
com.infa.products.ldm.filescanner.file.pro
cessor.api.
FileProcessorException: 
java.util.concurrent.ExecutionException: 
com.infa.products.ldm.filescanner.file.pro
cessor.api.
FileProcessorException: 
com.infa.products.ldm.ingestion.exceptions
.
DataValidationException: 
[DataValidationException_00009]

EIC-5906 When you initiate Catalog Service for Enterprise Data 
Catalog 10.2 Update 2, the Catalog Service does not 
start.

EIC-5860 When you run a PowerCenter resource that has 
approximately 600 mappings with load type configured 
as medium and scanner memory set to high, the 
resource run fails with the error "String index out of 
range: -1".

EIC-5768 The lineage diagram and the schema name are not 
displayed in the popup that appears when you move 
the mouse pointer on an external object such as a 
table or a view.

EIC-5734 When you run a HDFS resource on an XML file that has 
more than 1000 elements, the profiling run fails for the 
resource.

EIC-5407 The Informatica Platform resource fails with the 
following error:
"ArrayIndexOutOfBoundsException".

EIC-5374 Custom lineage for a data source that includes tables 
on either side of the seed asset displays the tables as 
a group.

EIC-5306 A resource fails when you renew the Kerberos ticket 
while the resource is running.

EIC-4640 Enterprise Data Catalog does not add a business title 
to a resource if the resource name contains a locale 
character.

EIC-4626 An Informatica Platform resource fails if a mapping 
contains unstructured files, such as PDF.

EIC-4545 You cannot delete multi-valued custom attribute values 
of reference data type in Enterprise Data Catalog.
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Bug Description

EIC-4053 When you install Enterprise Data Catalog on an 
embedded cluster and you have a Web proxy server 
configured in /etc/yum.conf, you might encounter 
issues. To resolve this issue, the line proxy=none 
needs to be added to the following repository files:
- ambari.repo
- HDP.repo
- HDP-utils.repo

EIC-2975 Duplicate mapping objects appear in the lineage and 
impact view for a table linked to a mapping containing 
the lookup transformation.

EIC-14407 The regular expression that selects the subset of a 
schema does not work for a Hive metadata resource.

EIC-13725 The import job fails with a null pointer exception when 
you update the custom attribute value of a reference 
data type in the import file. This issue occurs for 
business glossary assets.

EIC-13723 When you run a resource, the Solr process waits for 
the .lock files in HDFS to be deleted.

EIC-13443 Sometimes, you cannot view the business title of a 
resource in Enterprise Data Catalog.

EIC-12993 The pre-validation utility validates 2 GB of free disk 
space required in the /usr and /var directories.

EIC-12822 For the Informatica Platform resource, additional 
mappings are extracted in Enterprise Data Catalog for 
the mapping instance when there are no mapping 
parameters.

EIC-12551 When you run profiling on a Salesforce resource, 
sometimes, the profiling fails for a few tables and the 
error "ERROR: nsort_define() returns -26" appears.

EIC-12493 The PowerCenter resource fails with the following error 
during the conversion of XMI to XDoc files:
"java.lang.ArrayIndexOutOfBoundsException".

EIC-12474 Enterprise Data Catalog displays the instance name 
instead of the database name for an Oracle resource.

EIC-12142 The pre-validation utility fails when it validates the 
prerequisites to create an Informatica Cluster Service. 
The failure occurs when you specify a custom Hadoop 
directory that is nested within another directory.

EIC-12057 Custom property added that you can use when you 
deploy Enterprise Data Catalog on a WANdisco Fusion-
enabled cluster. You can use the property to resolve 
the issues on clusters where WANdisco Fusion is not 
enabled.
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Bug Description

EIC-11880 The Ambari_server_launch.sh and the 
Ambari_agent_install.sh scripts add the export 
PYTHONHTTPSVERIFY=0 line in the /usr/sbin/
ambari-server and the /usr/sbin/ambari-agent 
files every time you start the Informatica Cluster 
Service. The line must be added only if it does not 
exist.

EIC-11879 The Catalog Service uses a CPU core continuously 
even when there are no processes running or initiated.

EIC-11597 File System scanner fails when you use the Server 
Message Block (SMB) protocol.

EIC-11597 The File System resource fails when you use the Server 
Message Block (SMB) protocol to extract metadata 
from the file system.

EIC-11484 After you import a CSV file that has assets with 
associated custom attribute values, Enterprise Data 
Catalog does not display the associated custom 
attribute values for the assets.

EIC-11371 If the resource name, application name, and parameter 
file share the same name, the Informatica Platform 
resource fails with the following error:
ERROR 
com.infa.products.ldm.lineageservice.
client.impl.LineageServiceClientImpl- 
Sep 14, 2018 3:21:46 PM 
com.infa.products.ldm.scanners.mrsscanner.
cmd961bundle.
LineageServiceCaller$LineageServiceTask 
disconnect

EIC-11357 After you create and run an SAP Business Objects 
resource, Enterprise Data Catalog does not display the 
lineage information for the crystal reports.

EIC-11335 The lineage summary does not display flat files that 
are present in the Window File System resource. This 
issue occurs when you use FTP connection type to 
configure the Windows File System resource.

EIC-11289 When you create a Azure Microsoft SQL Server 
resource, enable data discovery, and run the resource, 
the temporary tables that are created during the 
resource run are not deleted by default.

EIC-11282 In the Overview tab, Enterprise Data Catalog does not 
display the source description of an associated 
business term for an asset. This issue occurs after you 
upgrade Enterprise Data Catalog from version 10.2.0 to 
10.2.2.
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Bug Description

EIC-11229 When you configure an Informatica Platform resource 
with an incorrect domain name, the resource fails and 
the scanner log file points to the lineage service log 
file incorrectly.

EIC-11220 If a custom attribute of reference data type includes 
the ampersand (&) symbol in the name, Enterprise Data 
Catalog appends "amp" with the custom attribute 
name.

EIC-11202 When you run an HDFS resource after you run a 
PowerCenter resource with Auto Connection 
Assignment, the HDFS resource run takes a long time 
to complete.

EIC-11178 When you run a resource that has empty source files, 
the profile run fails and a null pointer exception 
appears in the log file.

EIC-11140 Data validation fails for an Erwin resource because the 
resource does not support multi-valued attributes.

EIC-11065 When an HDFS connection is parameterized, the 
connection assignment path displays the parameter 
value appending the path for a PowerCenter resource.

EIC-11053 The test connection fails for the 
UCF.MongoDBNoSQLDatabase resource and the 
following error appears:
Error com.mongodb.MongoCommandException: 
Command failed with error 13: 'not 
authorized on 
admin to execute command { listDatabases: 
1 }' 
on server inkrh65qa01:27017. 
The full response is { "ok" : 0.0, 
"errmsg" : 
"not authorized on admin to execute 
command

EIC-11019 Sometimes, the inferred data domains appear in green 
instead of orange in the Similar Column section in the 
Overview tab.

EIC-11004 An incorrect URL is generated if you provide the region 
name in the Amazon S3 URL.

EIC-10255 Profiling fails for a resource if you add LDAP user 
instead of the domain user in the Data Integration 
Service properties of the resource.

EIC-1486 The Transformation Logic view displays inaccurate 
mapping names for the Informatica Cloud Services 
transformations.
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The following table describes closed enhancement requests:

Bug Description

EIC-5268 For the Informatica Platform resource, you cannot view the lineage in Enterprise Data Catalog when 
the custom SQL query is parameterized in the mapping.

EIC-13569 In Enterprise Data Catalog, you cannot view the lineage information for an asset after you assign a 
business title or custom attribute value to the asset.

Enterprise Data Lake Fixed Limitations

Review the Release Notes of previous releases for information about previous fixed limitations.

The following table describes fixed limitations:

Bug Description

IDL-9988 When you perform operations such as import, publish, search, or data preview in Enterprise Data 
Lake, the application displays all Hive schemas in the data lake, including schemas for which you do 
not have permissions.

IDL-8888 When the name of the Informatica security domain to which your user account belongs contains 
spaces, and you perform an upload, publish, or download activity in Enterprise Data Lake, the 
activity is not displayed in the application home, activity, and project pages.

The following table describes closed enhancement requests:

Bug Description

IDL-11420 The application no longer makes requests to external web sites during the log in process.

Mappings and Workflows Fixed Limitations and Closed Enhancements

Review the Release Notes of previous releases for information about previous fixed limitations.

The following table describes fixed limitations:

Bug Description

MWF-1680 The Data Integration Service can leak memory when you run a large number of workflow 
applications and the workflows include mappings that run from an operating system profile.

MWF-1668 If you bind a workflow variable to a mapping output, the Data Integration Service does not update 
the variable value if the mapping output is null.

MWF-1639 If you bind the taskStatus output to an integer variable, a workflow task returns a taskStatus value 
of 0 regardless of the success or failure of the task.

MWF-1636 The Data Integration Service can generate an excessive quantity of threads and other resources 
when you run a workflow that sends an email, for example in a Notification task.
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Bug Description

MWF-1631 If a workflow runs from an infacmd command and infacmd loses contact with the Data Integration 
Service, infacmd reports the workflow as failing to start while the workflow starts correctly.

MWF-1621 The workflow engine does not start if it encounters a locked process in the workflow database.

MWF-1597 You can save a workflow in which a task instance does not specify a task to perform, which can 
cause the workflow to fail at run time.

IDQ-7594 If you run multiple mappings with Match transformations concurrently, the mappings might 
generate multiple cache data files with the same name. The Data Integration Service might fail to 
delete all of the cache data files, and therefore the mappings might fail.

IDQ-7162 The Match transformation might not add all matching records to the correct clusters if the 
transformation input data includes very large record groups.

BDM-20274 If you run a mapping during the last week of the year and the week ends in the next year, the system 
parameter MappingRunStartTime increments the year by 1. The week begins on Sunday and ends on 
Saturday.
For example, the last week of 2018 included Sunday, December 30th and Monday, December 31st. If 
you ran a mapping on December 30th or December 31st, the parameter had a value of 12/30/2019 
or 12/31/2019 respectively.

BDM-18771 The infacmd wfs upgradeWorkflowParameterFile command can take a long time to complete the 
upgrade of a set of workflow parameter files.

BDM-18115 The LTRIM and RTRIM functions do not trim spaces when the following conditions are true:
- An expression is nested in multiple levels of LTRIM or RTRIM functions, such as 
LTRIM(LTRIM(<expression>)) or RTRIM(LTRIM(<expression>)).

- The nested expression references a column in a Hive table that originates from an SQL override.

BDM-17376 You might get unexpected results in a mapping with a Union transformation when the following 
conditions are true:
- The Union transformation has at last three input groups.
- The same two ports are unconnected in all the groups.
- The mapping contains a downstream transformation that filters data.
The transformation might incorrectly filter data that should be retained, or it might retain data that 
should be filtered out.

The following table describes closed enhancement requests:

Bug Description

MWF-1638 The Data Integration Service writes log messages to describe workflow engine activity when the 
workflow engine starts up. The Data Integration Service writes the number of workflow instances 
that the workflow engine processes to the log. The Data Integration Service also writes the workflow 
name, application name, and instance ID to the log.

Parameters Fixed Limitations

Review the Release Notes of previous releases for information about previous fixed limitations.
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The following table describes fixed limitations:

Bug Description

BDM-17211 If you resolve mapping parameters in a mapping that contains AppSDK data objects, an exception 
occurs when you perform the following actions:
- Run the mapping.
- Run data preview.
- Show the execution plan.

Profiles and Scorecards Fixed Limitations

Review the Release Notes of previous releases for information about previous fixed limitations.

The following table describes fixed limitations:

Bug Description

IDE-3703 Enterprise discovery profile with primary key and foreign key inference options do not work when 
the profiling warehouse uses an ODBC connection with UseDSN option.

IDE-3640 In Informatica Analyst, when the Scorecard workspace is active and you perform any task in the 
Analyst tool, high CPU usage and memory utilization are observed.

IDE-3463 After you upgrade from 10.1.1 HotFix 1 to 10.2.1, you cannot run a few existing scorecards.

IDE-3448 You cannot run a scorecard after you delete a rule in the Metrics tab of the scorecard.

IDE-3396 After you upgrade to version 10.2, the scorecard run for logical data objects fails with null pointer 
exception.

IDE-3180 When you run a column profile on a source that has a column with the precision value greater than 
255, you cannot infer data types on the column.

IDE-3161 In Informatica Analyst, when you use Internet Explorer to create a column profile that has a 
Japanese character in the profile name, the page becomes unresponsive.

IDE-3115 Column profile fails for a Hive partitioned source.

IDE-3065 When you run enterprise discovery profile with data domain discovery, profiling fails for some Hive 
sources.

BDM-19917 Profiling run fails when you run the infacmd ps execute infacmd command.

BDM-17440 When you create a column profile or data domain discovery profile on a partitioned Hive table and 
run the profile on the Blaze engine, the profile run intermittently fails.

Security Fixed Limitations

Review the Release Notes of previous releases for information about previous fixed limitations.

18 2020-06-22



The following table describes fixed limitations:

Bug Description

ANT-520 If a secure domain is SAML-enabled and you log in to the Administrator tool as an SAML user, the 
Administrator tool does not show the user activity log.
The Analyst tool shows the user activity log but does not show the name of the user in the user field of 
the activity log.

Third-Party Fixed Limitations

Review the Release Notes of previous releases for information about previous fixed limitations.

The following table describes fixed limitations:

Bug Description

BDM-10410 For Hortonworks clusters, insert into a Hive target table on Amazon S3 can fail if the table is 
enabled for transactions.

10.2.2 Known Limitations

Application Service Known Limitations

Bug Description

OCON-13454 The Developer tool fails to connect to an active Metadata Access Service process even if the 
Metadata Access Service is configured for high availability.

OCON-13257 When you import a complex file object, an HBase object, or a Hive object from a Hadoop cluster, 
the metadata import fails if the domain and the Metadata Access Service use Kerberos 
authentication.

MRS-1617 When you configure the monitoring Model repository on an Oracle database, an exception appears 
when the number of objects fetched by the monitoring Model Repository Service for the mapping 
job statistics exceeds 1000 objects.

MRS-1585 An error appears when you enable Git version control system for a Model repository if the global 
repository name shares the same name with another Model repository, and if both the repositories 
share the local repository.
Workaround: Use separate local repository for the Model Repository Services.

MRS-1570 After you assign the Show Security Details privilege, you cannot view upstream dependencies for 
a reusable Model repository object unless you have read permission on the dependent projects.

MRS-1463 The version history for Model Repository Service objects are lost if the content of the versioned 
Model repository is migrated from one Perforce depot to another.
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Bug Description

BDM-19090 The Data Integration Service hangs when the service runs concurrent SQL data service mappings.

MRS-1861 Sometimes, the out of memory error might appear for Model Repository Service.
Workaround: Increase the Maximum Heap Size value in Advanced Properties to 1536m or 2048m.

Big Data Management Known Limitations

The following table describes known limitations:

Bug Description

OCON-9377 When you configure Sqoop and run a Teradata Parallel Transporter mapping on a Cloudera cluster 
to export data of the Byte or Varbyte data type to a Teradata target, the mapping fails on the Blaze 
engine.

OCON-9376 If you configure Sqoop to export data of the Blob or Clob data type to a Teradata target, TDCH 
mappings fail on the Spark engine.

OCON-9143 In the read and write operations for a complex file data object, you cannot edit the precision and 
scale of elements within a field that is of a complex data type.
For example, if Field1 is of type array with string elements, you cannot edit the precision and scale 
of the string elements.

OCON-9005 When you run TDCH mappings on the Hive engine to write time data to a Teradata target, the 
nanosecond part is truncated.

OCON-8850 If you configure Sqoop to export data of the Timestamp data type from a Hive source to a 
Microsoft Azure SQL Data Warehouse target, the mapping fails.

OCON-8779 If you configure Sqoop to export data of the Real data type to IBM DB2 z/OS targets, the mapping 
fails.

OCON-7687 When you export data through Sqoop and the columns contain mixed case characters, the 
mapping fails.

OCON-7669 When you configure Sqoop and OraOop, and export data to an Oracle target that contains mixed 
case characters in the table name, the mapping fails.
Workaround: Use the generic Oracle JDBC driver to export data.

OCON-7429 When you run a Teradata Parallel Transporter mapping on a Hortonworks cluster and on the Blaze 
engine to write data of the Byte or Varbyte data type to a Teradata target, the data gets corrupted. 
This issue occurs when you use the hdp-connector-for-teradata-1.5.1.2.5.0.0-1245-
distro.tar.gz JAR.
Workaround: Use the hdp-connector-for-teradata-1.4.1.2.3.2.0-2950-
distro.tar.gz JAR.

OCON-730 When you export data through Sqoop and there are primary key violations, the mapping fails and 
bad records are not written to the bad file. (456616)

OCON-7216 If a Sqoop source or target contains a column name with double quotes, the mapping fails on the 
Blaze engine. However, the Blaze Job Monitor incorrectly indicates that the mapping ran 
successfully and that rows were written into the target.
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Bug Description

OCON-7212 If there are unconnected ports in a target, Sqoop mappings fail on the Blaze engine. This issue 
occurs when you run the Sqoop mapping on any cluster other than a Cloudera cluster.
Workaround: Before you run the mapping, create a table in the target database with columns 
corresponding to the connected ports.

OCON-7205 When you run a Sqoop mapping on the Blaze engine to export data of the Numeric data type from 
Netezza, the scale part of the data is truncated.

OCON-17245 When you run a Sqoop mapping on a Kerberos-enabled HDInsight cluster with ADLS as storage, 
the mapping fails on the Blaze engine.

OCON-17194 Microsoft Azure Blob Storage incorrectly appears as a source option for the Lookup 
transformation on the Spark and Databricks Spark engines, but this option is not supported. 
Mapping validation fails with the following error when you select Microsoft Azure Blob Storage as 
a lookup source on the Spark or Databricks Spark engine:
[Spark Validation] The Integration Service cannot 
use the Spark engine to push the transformation 
[test_input_txt_Read1] of type [LookupTx] to 
the Hadoop cluster. [ID: TRANSFORMATION_NOT_SUPPORTED] 
test_input_txt_Read1

OCON-16315 The Data Integration Service fails with out of memory errors when you run a large number of 
concurrent mappings with data object read and write operations that project columns as complex 
data types.
Workaround: Perform any of the following steps:
- Increase the heap memory settings on the machine where the Data Integration Service runs.
- Reduce the number of concurrent mappings that process complex data types.
- Set the Data Integration Service custom property ExecutionOptions.CBOStatCacheSize to a 

reasonably small number.

IN-3362 A data object with an intelligent structure model might accept JSON input files formatted with 
newlines between attributes as suitable for partitioning, even though the files cannot be 
partitioned. This might cause data that corresponds to the model to be identified as lost data in 
the Spark log.

BDM-4597 A mapping with a joiner transformation that processes more than 4,294,967,294 rows in a single 
partition will fail.
Workaround: If possible, increase partitioning on the source.

BDM-23906 The infacmd ccps listClusters command fails when the domain contains a Databricks cluster that 
does not have any custom tags.
Workaround: Manually add a custom tag to the cluster or create the cluster through a cluster 
workflow.

BDM-23740 If you update the REST Operations Hub properties in the Administrator tool, the changes fail to 
reflect when you run the infacmd roh listROHProperties command.
Workaround: Update the REST Operations Hub properties from the command line prompt.

BDM-23631 When you run a mapping that generates multiple applications on a Spark engine, the mapping fails 
when a source does not have any data.

BDM-23575 The number of nodes is incorrectly displayed in the session log for the mappings that run on 
nodes that are labeled in a cluster that runs on Blaze and Spark engines.
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Bug Description

BDM-23550 When an Update Strategy transformation contains an insert, update, or a delete operation, and a 
JDBC target, incorrect number of inserted, updated, or deleted rows appear from the Spark events.

BDM-23392 When a mapping that runs on Spark uses an Update Strategy transformation, table constraints 
might cause a BatchUpdateException and mapping failures.
Workaround: Edit the Spark.JdbcNumPartition setting in the mapping Runtime Properties to 
reduce the number of partitions to 1. This causes all rows to be processed as a single partition.

BDM-23317 When you monitor statistics for the Data Integration Service configured with file-based queuing, 
the jobs incorrectly appear to run even when the job state is queued.

BDM-22490 When a dynamic mapping that runs on Spark uses an Update Strategy transformation, adding a 
column to the Hive target table schema causes the mapping to fail.

BDM-22481 When the Spark engine processes an input value of zero in a decimal port that is configured with 
equivalent precision and scale, the engine treats the value as data overflow and the return value is 
NULL.

BDM-22282 The Spark engine might take up to 30 minutes to run a mapping that contains a Python 
transformation if you pass a large number of ports to the Python transformation.

BDM-22260 Cannot get Spark monitoring statistics for a mapping run that uses any of the following 
connections: Google BigQuery, Google Cloud Storage, Google Cloud Spanner, and Google 
Analytics.

BDM-2222 The Spark engine does not run the footer row command configured for a flat file target. (459942)

BDM-2141 Mapping with a Hive source and target that uses an ABS function with an IIF function fails in the 
Hadoop environment. (424789)

BDM-2137 Mapping in the Hadoop environment fails when it contains a Hive source and a filter condition that 
uses the default table name prefixed to the column name.
Workaround: Edit the filter condition to remove the table name prefixed to the column name and 
run the mapping again. (422627)

BDM-2136 Mapping in the Hadoop environment fails because the Hadoop connection uses 128 characters in 
its name. (421834)

BDM-20856 When you import a cluster workflow, the import wizard does not include the option to choose the 
non-native connection that was associated with the Create Cluster task.
Workaround: After you import the workflow, manually assign a Databricks or Hadoop connection 
to the Create Cluster task.

BDM-20697 If you use the numberOfErrorRows system-defined mapping output in a mapping that runs on the 
Spark engine, the engine returns an incorrect value for the mapping output.

BDM-18140 A mapping that reads a large number of reference tables may take longer than expected to run on 
the Spark engine. The issue is observed when the mapping includes transformations that 
collectively read 140 reference tables.
Workaround: Run the mapping on the Blaze engine.

BDM-17485 Mapping or mapplet that has the same name or any non-reusable transformation with the same 
name as mapplet or mapping fails to import into the Model repository.
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Bug Description

BDM-17174 When memory usage reaches the maximum container size, YARN kills the container.
Memory usage on the OOP Container Manager reaches the maximum container size if the 
following conditions are true:
- Concurrent jobs run for longer than two days.
- The Blaze engine has not reached the idle timeout limit or the sunset time.

BDM-16521 On Oracle and DB2, when a Lookup transformation contains a Text data type column and you 
import the mapping into the Developer tool, the Text datatype is mapped to the Clob datatype and 
the mapping fails with an error. Similarly, the Binary data type gets imported into the Model 
repository as a Blob data type and the mapping fails.
Workaround: Edit the column type in the Lookup transformation to run the mapping.

Big Data Streaming Known Limitations

This following table describes known limitations:

Bug Description

IIS-2781 A mapping with Hive target fails after 24 hours on a secure cluster.

IIS-2761 If a mapping contains multiple lookups on the same flat file data object, you cannot view the Spark 
execution plan in the Developer tool or Administrator tool.
Workaround: Create a physical data object on the same physical source for each Lookup 
transformation in the pipeline.

IIS-2573 When you run a dynamic mapping and you connect the Window port from a Window transformation to 
an Aggregator transformation, the mapping validation fails.

IIS-2448 When you run a mapping with Joiner transformation, the output is not as expected because the late 
data is not cleared even after watermark delay.

IIS-2329 When you remove or update the AWS credentials file with an invalid credential, streaming mappings 
that use Amazon Kinesis connections hang.

Developer Tool Known Limitations

The following table describes known limitations:

Bug Description

PLAT-17627 When you run multiple concurrent mappings with Lookup and Sorter transformations in the native 
environment, the mappings might hang.

PLAT-16416 When you import a mapping from PowerCenter that contains a mapplet and an Expression 
transformation, the following error sometimes appear in the log: The transformation 
instance cannot be connected to the active transformations.
Workaround: Ignore the error and import the mapping.
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Bug Description

OCON-990 The Developer tool imports the DECFLOAT data type of IBM DB2 for z/OS tables as Char(0). 
(455216)

OCON-9806 If the ODBC data source contains a special character in a column name, mappings that read data 
from or write data to Microsoft SQL Server databases fail.

BDM-19301 The Incremental Deployment Wizard analyzes the impact to run-time objects one at a time, and it 
cannot perform an analysis in bulk. Analysis is slow for applications with a large number of 
objects.

Enterprise Data Catalog Known Limitations (10.2.2)

The following table describes known limitations:

Bug Description

EIC-8187 When you configure a user with read and write permission for one resource in the Catalog 
Administrator, Enterprise Data Catalog displays the total resource count instead of a count of one 
in the search page for the user.

EIC-8171 When you delete an Informatica Axon resource, Enterprise Data Catalog does not delete the 
custom attribute assigned to the asset from the catalog.

EIC-8127 When you search for an asset name that contains an underscore (_), the search results page does 
not return any result.

EIC-7741 The Column profile option is incorrectly enabled for unstructured data sources.
Workaround: Use Data domain discovery option or Column profile and data domain discovery 
option for unstructured data sources.

EIC-7622 Custom metadata resource does not extract connection parameters for Business Intelligence 
metadata sources.

EIC-7583 The relationships REST API returns different levelCount details for the same query.

EIC-7406 After you fix the incorrect details in a reusable configuration used for a resource, the changes do 
not take effect on the resource.

EIC-7405 You cannot select a negative value using the slider filter for an integer custom attribute.
Workaround: Configure the custom attribute to allow filter based on range.

EIC-6927 A run-time error appears for a data domain or composite data domain if the following conditions 
are true:1.
You open the Catalog Administrator in Internet Explorer version 11.2.
You create and save a data domain or composite data domain.
This issue occurs only for data domains and composite data domains that have a non-EN character 
in their names.

EIC-6084 The ERROR: java.lang.IndexOutOfBoundsException error message appears when you run 
the infacmd collectAppLogs command to collect log files of YARN applications. The error 
occurs when you create and enable the Catalog Service on an existing Hortonworks cluster that is 
enabled for WANdisco Fusion.
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Bug Description

EIC-4015 When you run an Avro file with fixed data type, the core scanner displays the precision as 
undefined and the profile run fails with a null pointer exception.

EIC-3848 Profiling scanner does not run on Avro and Parquet files if the files are located in OneDrive, SFTP, 
or remote Windows location.

EIC-3288 When a column in a data source does not contain any data, the Similarity Discovery system 
resource does not discover columns based on column name.

EIC-1837 Relationship diagram does not show synonyms.

EIC-1835 In the Asset Details view of a synonym, the Contains panel displays source qualifier and mapping 
assets along with columns instead of just columns.

EIC-15696 The infacmd collectAppLogs command fails with the collectAppLogs] failed with 
error [Java heap space] error message.

EIC-15657 In Enterprise Data Catalog, you can create a Universal Connectivity Framework (UCF) resource 
using REST API. However, you cannot edit the resource.
Workaround: Contact Global Customer Support for a UCF license.

EIC-15650 UCF resource model registration fails for SAP HANA resource after Catalog Service upgrades 
successfully.

EIC-15338 In the Catalog Administrator, when you apply a custom attribute value to all assets in the resource, 
the following issues occur in the Notification page:
- The Notification page displays duplicate notification messages.
- The Notification page displays the notification message before the asset changes reflect in the 

Catalog.
- The notification message displays the object ID of an asset instead of the asset name.

EIC-14761 Sometimes, Enterprise Data Catalog displays an incorrect notification message in the Change 
Summary for a synonym asset.

EIC-14746 Enterprise Data Catalog does not send a notification message when a user associates or removes 
a business title from a stored procedure. This issue occurs if you have followed the enrichment 
changes of the stored procedure asset.

EIC-14668 In the Catalog Administrator, when you propagate the stakeholder value to all assets in the 
resource while you create a resource, the Relationship tab displays incorrect information for an 
asset.

EIC-14600 For custom metadata resources, you cannot specify multiple values for the multi-valued attributes 
that are configured in the Enterprise Data Catalog model.

EIC-14590 In the Catalog Administrator, the Manage menu does not display the Reusable Configuration 
option. This issue occurs only if you use Microsoft Internet Explorer version 11.1446.

EIC-14452 In the Enterprise Data Catalog, a user is unable to provide a review, ask a question, or answer a 
question about an asset if the username contains Chinese characters.

EIC-14429 Sometimes, Enterprise Data Catalog displays a previously assigned business title even after you 
update the business title for an asset.
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EIC-14406 Enterprise Data Catalog does not display the path of an asset in the search results page. This issue 
occurs if you search for a column asset with keywords "column contains" followed by the asset 
name in the search box.

EIC-14374 Enterprise Data Catalog displays an incorrect notification message after you delete a description 
of an asset.

EIC-14183 The Resource Name filter option in the Assets Followed page does not work as expected.

EIC-14140 Sometimes, if you follow the collaboration changes of an asset, Enterprise Data Catalog does not 
send you a notification message.

EIC-14127 Enterprise Data Catalog stops unexpectedly when you type a percentage sign (%) after the asset 
name in the Asset Name field of the Notification page.

EIC-13718 The filters in the Relationship tab do not work as expected.

EIC-13708 Enterprise Data Catalog does not extract metadata or lineage information from an Informatica 
Intelligent Cloud Services (IICS) metadata source that includes an invalid data mapping with a 
Google BigQuery source. The invalid mapping between Google BigQuery and IICS is caused by IICS 
not supporting the Google BigQuery numeric data type.

EIC-13614 Enterprise Data Catalog displays an incorrect notification message after you delete a question.

EIC-13577 After you assign a data owner to a resource and an asset, there is a user role and privileges 
conflict between the data owners.

EIC-13418 You cannot cancel a resource purge operation.

EIC-13353 In the Catalog, the average ratings count is incorrect when multiple users provide ratings and 
review at the same time.

EIC-13305 When you run a profile on a Salesforce resource, sometimes, the profiling fails and an error 
appears for a few tables in the resource.

EIC-13285 
and 
EIC-13181

Enterprise Data Catalog does not display lineage for a view that includes advanced Google 
BigQuery functions and syntaxes such as ARRAY, UNNEST, CODE_POINTS_TO_BYTES, RANK, 
GROUP EACH BY and CODE_POINTS_TO_STRING.

EIC-13271 You cannot view the lineage for a view created in a Google BigQuery table if the following 
conditions are true:
1. You create a table in a Google BigQuery project, and create a resource for the table.
2. You create a view for the table in another Google Big Query project, and create a resource for the 

view.
3. You run both the resources.
4. Generate the lineage of the view.

EIC-13164 The Notification page does not display a notification message when a CSV file is added to an 
asset that you follow.

EIC-13142 You cannot assign stakeholders to an asset if the asset name contains Chinese characters or 
UTF-8 characters.

EIC-13114 The lineage diagram of a synonym asset hangs unexpectedly if you drill down to display the 
lineage at the column level.
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EIC-13002 Deleting an associated business glossary from a business glossary resource does not remove the 
associated business glossary term from the search results in Enterprise Data Catalog. This issue 
occurs for Business Glossary and Axon resource types.

EIC-12990 Enterprise Data Catalog does not send a notification message if you make changes to an asset 
that has special characters in its name.

EIC-12985 The Catalog Administrator and Enterprise Data Catalog stop unexpectedly in Microsoft Internet 
Explorer version 11.1446. This issue occurs when you create a custom attribute in Catalog 
Administrator and assign a custom attribute value to an asset in Enterprise Data Catalog.

EIC-12687 In the Library workspace, the resource filter section displays the Change Notification Resource 
option in the Resource Type list even if you have not selected the Enable Email Notifications for 
Asset Changes option in the Catalog Service properties of the Informatica Administrator.

EIC-12423 You cannot reject an inferred business term if the business term was previously associated with an 
asset more than two times.

EIC-11876 When you create a single value or multi-value custom attribute of reference data type with the GET 
"http://<hostname>:<port>/access/2/catalog/models/referenceAttributes REST 
API, update the value in Enterprise Data Catalog, and refresh the page, the single value attribute 
disappears and the multi-value attribute displays all possible values.

EIC-11572 When you search for a few data sources and reports that are extracted to the catalog using a 
Workday resource type, Enterprise Data Catalog does not display the assets in search results.
Workaround: Enclose the search string in double quotes (“ “) when you perform a search in the 
Enterprise Data Catalog.

Enterprise Data Lake Known Limitations

The following table describes known limitations:

Bug Description

IDL-4089 When you unshare a visualization Notebook, the asset details page shows the Zeppelin welcome 
page.

IDL-3615 When you share a visualization Notebook, the asset details page shows the Zeppelin welcome page.

IDL-3189 When you import data or preview data from Azure SQL Data Warehouse, the operation fails.
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Profiles and Scorecards Known Limitations

The following table describes known limitations:

Bug Description

IDE-3693 In the Analyst tool, drilldown on a column with Date data type fails when the following conditions are 
true:
1. You choose Oracle JDBC connection for the profiling warehouse.
2. You choose a JDBC connection to connect to a source to import a table.
3. You create and run a column profile on the table.

IDE-3178 When you enable operating system profile and drilldown on the column profiles or scorecard results, 
the drilldown sometimes fail.

IDE-3163 In Informatica Analyst, you cannot export profiles and scorecards if the pop-up blocker is enabled for 
the browser.

IDE-3155 The detail view for a column with data type Decimal takes a long time to appear if the profiling 
warehouse uses Microsoft SQL Server database.

IDE-3114 In the Analyst tool, you need to check in a profile after every edit to run a profile but you can edit and 
run a scorecard multiple times before you check in the scorecard if Team-based development is 
enabled.

IDE-3089 An error appears after you perform a query on the MRX_PROFILE_RULES view if the Model repository 
uses Microsoft SQL Server and Microsoft Azure SQL database.

IDE-3086 Create, open, and run profiles or scorecards takes a long time if the Model repository uses Microsoft 
Azure SQL database.

IDE-3075 In the Developer tool, when you run a column profile on a JSON data object, some fields might not 
appear in the profile definition or profile results.

IDE-3063 An exception appears when you run a column profile on an Avro or Parquet data object in Amazon S3 
bucket.

IDE-3061 An error appears when you create a column profile on an Avro data object that contains an array data 
type.

IDE-3057 When you run a column profile on a JSON data object, the special characters !, @, #, $, %, ^, & , and * 
in the column field names are replaced with underscores in the profile definition and profile results.

IDE-2769 When you run a SQL query that uses the MRX_SC_RULE_METRICS view, the query results appear after 
an indefinite period of time.

IDE-2695 In the Developer tool, when you create a column profile on a logical data object and add a filter to the 
profile, the filter preview does not appear.
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Reference Data Known Limitations

The following table describes known limitations:

Bug Description

IDQ-6656 You cannot import an XML object to the Model repository when the following conditions are true:
- The XML object includes a reference table.
- The Model repository connects to an Oracle reference data database, and the reference table in the 

XML object originates in a Microsoft SQL Server reference data database.

Rule Specifications Known Limitations

The following table describes known limitations:

Bug Description

IDQ-6355 The Analyst tool fails to invalidate a rule specification when you configure a case conversion function 
in a rule statement for a non-string data type.

IDQ-5317 The Analyst tool generates an error if you try to generate a mapplet from a rule specification after you 
perform the following steps:
1. You copy a rule statement from a parent rule set to a child rule set.
2. You delete the child rule set.
Workaround: Save the current rule specification after you perform each copy operation.

IDQ-5316 The Analyst tool generates an error if you try to save a rule specification or generate a mapplet from a 
rule specification in the following case:
- You copy a rule set from more than one other rule specification into the current rule specification.
Workaround: Save the current rule specification after you perform each copy operation.

Third-Party Known Limitations

The following table describes known limitations:

Bug Description

OCON-9943 If you configure Sqoop to import time data from a Netezza database, the mapping fails.
Apache ticket reference number: SQOOP-2978

OCON-8786 If you configure Sqoop to export data of the Clob or DBClob data type to IBM DB2 z/OS 
targets, the mapping fails.

OCON-8561 If you configure Sqoop to export data of the Money data type to Microsoft SQL Server 
targets, the mapping fails.

OCON-8387 If you configure TDCH and Sqoop and run a mapping on the Blaze or Spark engine to export 
data of the Time data type, only milliseconds are written to the target. The nanosecond part 
is truncated.
Cloudera ticket reference number: 124306
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OCON-8332 If you configure Sqoop to export data of the Clob or DBClob data type to IBM DB2 targets, 
the mapping fails.

OCON-7974 If you configure Sqoop and a column name contains spaces, the mapping fails.
Apache ticket reference number: SQOOP-2737

OCON-7620 If you import data from an IBM DB2 source through Sqoop and the table name contains 
mixed case characters, the mapping fails.
Sqoop JIRA issue number: SQOOP-3211

OCON-7505 Sqoop mappings that read byte or varbyte data from a Teradata source and write it to a 
Teradata target fail on the Blaze engine. This issue occurs if you use Cloudera Connector 
Powered by Teradata.
Cloudera ticket reference number: 124305

OCON-7504 When you use Sqoop to read data of the Timestamp data type from a Teradata source and 
write it to a Teradata target, only milliseconds are written to the target. This issue occurs if 
you run the Teradata Parallel Transporter mapping on a Cloudera cluster and on the Blaze 
engine.
Cloudera ticket reference number: 124302

OCON-7503 When you use Sqoop to read time data from a Teradata source and write it to a Teradata 
target, the fractional seconds get corrupted. This issue occurs if you use Cloudera 
Connector Powered by Teradata or Hortonworks Connector for Teradata, and run the 
mapping on the Blaze engine.
Cloudera ticket reference number: 124306

OCON-7459 When you export data to an IBM DB2 target through Sqoop, the mapping fails if all of the 
following conditions are true:
- You create or replace the IBM DB2 target table at run time.
- The IBM DB2 target table name or column names contain mixed case characters.
- You run the mapping on a Cloudera 5u8 cluster.
Apache ticket reference number: SQOOP-3212

OCON-7431 When you read time data from a Teradata source and write it to a Teradata target, the 
fractional seconds get corrupted. This issue occurs if you run the Teradata Parallel 
Transporter mapping on a Hortonworks cluster and on the Blaze engine.
Cloudera ticket reference number: 124302

OCON-7219 When you run a Sqoop mapping on the Blaze engine to export Teradata float data, the data is 
truncated after the decimal point.
Cloudera support ticket number: 113716

OCON-7214 Sqoop mappings fail on the Blaze engine if you use a custom query with the Order By clause 
to import data.
Sqoop JIRA issue number: SQOOP-3064

OCON-7213 The Sqoop program does not honor the --num-mappers argument and -m argument when you 
export data and run the mapping on the Blaze or Spark engine.
Sqoop JIRA issue number: SQOOP-2837
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OCON-7211 When you run a Sqoop mapping to import data from or export data to Microsoft SQL Server 
databases that are hosted on Azure, the mapping fails.
Sqoop JIRA issue number: SQOOP-2349

OCON-2847 Loading a Microsoft SQL Server resource fails when TLS encryption is enabled for the source 
database and the Metadata Manager repository is a Microsoft SQL Server database with TLS 
encryption enabled. (452471)
Data Direct case number: 00343832

OCON-1100 When you export data to an IBM DB2 z/OS database through Sqoop and do not configure the 
batch argument, the mapping fails.
Workaround: Configure the batch argument in the mapping and run the mapping again. 
(459671)
Apache ticket reference number: SQOOP-2980

IIS-2719 If the mapping contains a passive Lookup transformation that is configured with an 
inequality lookup condition, the target receives the data later.

IIS-2484 When you write to a HBase target in an Amazon EMR cluster and the 
spark.hadoop.validateOutputSpecs property is set to true, the streaming mapping fails with 
an exception.
Workaround: Set the spark.hadoop.validateOutputSpecs property to false.
HBASE JIRA issue number: 20295

BDM-9585 Mappings fail on the Spark engine when you configure an SQL override to access a Hive 
view.
Apache Spark ticket reference number: SPARK-21154.

BDM-23420 A mapping with a Sorter transformation that contains datetime data in its default value 
changes the data when you run the mapping on a MapR cluster.
MapR ticket reference number: 00072094

BDM-23104 The Spark engine cannot write data to a bucketed Hive target if the Hadoop distribution is 
MapR.
MapR case number: 00074338

BDM-22675 Incorrect source statistics appear when the Spark engine processes a Union transformation.
Spark ticket reference number: SPARK-26683

BDM-22318 If a parameter default value has a newline character, the Spark engine creates additional 
rows and can shift column values to other columns.
Workaround: To resolve the issue with newline characters, use a SequenceFile format 
instead of a TextFile format for the target table.

BDM-17470 In an Azure HDInsight environment, if you enable Hive merge in an Update Strategy 
transformation and if Hive is enabled to execute vectorized queries, inserting data into 
specific columns fails.
Workaround: In the hive-site.xml on the cluster, set the hive.vectorized.execution.enabled 
property to false.
Apache Hive ticket reference number: HIVE-14076
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BDM-17204 If the impersonation user tries to run a mapping with HDFS source and does not have the 
DECRYPT_EEK privilege to read the file, the log file shows an incorrect error message.
HADOOP-12604

BDM-17020 When you run a mapping that uses a schema in an Avro file, the Spark engine adds a NULL 
data type to the primitive data types in the schema.

BDM-14438 If a Parquet file has an array of the format [map (struct, any)], then the mapping on the Spark 
engine fails with a spark.sql.AnalysisException exception.
SPARK-22474

BDM-14422 The mapping fails with an error on Spark engine due to duplicate columns in the Hive table.
SPARK-23519

BDM-14410 The mapping fails because the Spark engine cannot read from an empty ORC Hive source.
SPARK-19809

BDM-13650 Mappings fail on the Spark engine when the Spark engine runs on a secure HA cluster and 
the hadoop.security.auth_to_local property in the core-site.xml file contains a modified 
value. The mappings fail due to the following error:
Failed to renew token
Workaround: Configure the following property in the yarn-site.xml file using any node in the 
Hadoop cluster:
yarn.resourcemanager.address=<node name>
MapR ticket reference number: MAPREDUCE-6484

BDM-10570 The Spark job fails with out of memory errors when a mapping that converts relational data 
to hierarchical data contains more than three Aggregator and Joiner transformations.
Workaround: To convert relational data to a hierarchical data of more than four levels, 
develop more than one mapping to stage the intermediate data. For example, develop a 
mapping that converts relational data to a hierarchical data up to three levels. Use the 
hierarchical data in another mapping to generate a hierarchical data of four levels.
SPARK-22207

BDM-10455 Inserts into a bucketed table can sometimes fail when you use Hive on Tez as the execution 
engine. The issue is more probable if the table is a Hive ACID table and a delete operation is 
performed before the inserts.
Apache ticket reference number: TEZ-3814
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Transformations Known Limitations

The following table describes known limitations:

Bug Description

IDQ-6914 If you specify a reference table name as a parameter in a transformation, the transformation 
disregards the reference table name when you resolve the mapping parameters in the mapping 
canvas.

IDQ-6664 A mapping that contains a Labeler transformation or a Parser transformation fails validation when the 
following conditions are true:
- You configure the transformation to read a probabilistic model from a content set.
- You replace the probabilistic model in the content set with a probabilistic model of the same name 

from another content set.
When the conditions are true, the probabilistic model no longer appears in the transformation 
strategy.

IDQ-6662 A mapping that contains a Classifier transformation fails validation when the following conditions are 
true:
- You configure the transformation to read a classifier model from a content set.
- You replace the classifier model in the content set with a classifier model of the same name from 

another content set.
When the conditions are true, the classifier model no longer appears in the transformation strategy.

Workflows Known Limitations

The following table describes known limitations:

Bug Description

MWF-1430 When you assign the system parameter sys:ApplicationName or sys:MappingName to a Mapping 
task input in a workflow, the Mapping task input parameter does not read the system parameter 
values. Instead, the Mapping task input parameter reads the default value of the mapping parameter 
at run time.

MWF-1340 If a workflow contains parallel Mapping tasks and you cancel the workflow while the Mapping tasks 
are running, any mapping that has yet to start proceeds to run.
The issue arises when the following conditions are true:
- The number of mappings that the Mapping tasks specify is greater than the Maximum Worker 

Threads value on the Data Integration Service.
- You cancel the workflow while the mappings that the Maximum Worker Threads value specifies 

are running and other mappings have yet to start.
Workaround: Increase the Maximum Worker Threads value.

Emergency Bug Fixes Merged into 10.2.2
Informatica merged Emergency Bug Fixes (EBFs) from previous releases into version 10.2.2. These EBFs 
provided fixes for issues that were found in previous releases.

For a list of EBFs that were merged into version 10.2.2, see the following Informatica Knowledge Base 
article: https://kb.informatica.com/faq/7/Pages/22/569773.aspx.
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Informatica Global Customer Support
You can contact a Global Support Center by telephone or through the Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website 
at the following link: 
https://www.informatica.com/services-and-training/customer-success-services/contact-us.html.

To find online support resources on the Informatica Network, visit https://network.informatica.com and 
select the eSupport option.
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